Пример 5: Обтекание потоком воздуха грубого тела 

Руководство
Это руководство включает в себя:
· Возможности примера 4
· Общее представление о проблемах решателя
· Описание процесса симуляции в ANSYS CFX-Pre
· Получение решения с помощью ANSYS CFX-Solver Manager
· Визуализация результатов в ANSYS CFX-Post
Перед тем как запустить файл сессии, скопируйте файлы для примера из папки C:\Program Files\ANSYS Inc\v110\CFX\examples в Вашу рабочую директорию.
Вам потребуется скопировать следующие файлы:
· BluntBody.pre
· BluntBodyDist.cse
· BluntBodyMesh.gtm
Возможности Примера 5

Этот пример использует следующие возможности ANSYS CFX.
	Component
	Feature
	Details

	ANSYS CFX-Pre
(Препроцессор)
	User Mode
(Пользовательский режим)
	General Mode
(Основной режим)

	
	Simulation Type
(Тип симуляции)
	Steady State
(Стационарный)

	
	Fluid Type
(Тип жидкой среды)
	Ideal Gas
(Идеальный газ)

	
	Domain Type
(Тип домена)
	Single Domain
(Один домен)

	
	Turbulence Model
(Модель турбулентности)
	Shear Stress Transport

	
	Heat Transfer
(Перенос тепла)
	Isothermal
(Изотермический)

	
	Boundary Conditions
(Граничные условия)
	Inlet (Subsonic)
Вход (дозвуковой)

	
	
	Outlet (Subsonic)
Выход (дозвуковой)

	
	
	Symmetry Plane
(Плоскость симметрии)

	
	
	Wall: No-Slip
(Стенка: Без скольжения)

	
	
	Wall: Free-Slip
(Стенка: со свободным скольжением)

	
	Timestep
(Шаг по времени)
	Physical Time Scale
(Физическая шкала по времени)

	ANSYS CFX-Solver Manager
(Менеджер задач)
	Parallel processing
(Параллельное выполнение)
	 

	ANSYS CFX-Post
(Постпроцессор)
	Plots
(Схемы)
	Default Locators 
(Участки по умолчанию)

	
	
	Outline Plot (Wireframe) 
(Каркас)

	
	
	Sampling Plane 
(Выборочный план)

	
	
	Streamline 
(Линии тока)

	
	
	Vector 
(Вектор)

	
	
	Volume
(Объем) 

	
	Other
(Другое)
	Changing the Color Range 
(Изменение диапазона цвета)

	
	
	Instancing Transformation 
(Необходимая трансформация)

	
	
	Lighting Adjustment 
(Регулировка яркости)

	
	
	Symmetry 
(Симметрия)

	
	
	Viewing the Mesh 
(Просмотр сетки)


В этом руководстве Вы изучите:

· Решение и визуализация задачи в случае, когда одна из сторон геометрической модели является плоскостью симметрии.

· Using free slip wall boundaries on the sides of and above the domain as a compromise between accurate flow modeling and computational grid size. 

· Точное моделирование потока около стенки, используя модель турбулентности Shear Stress Transport (SST).

· Запуск решателя ANSYS CFX-Solver в параллельном режиме.

· Создание графика векторов в ANSYS CFX-Post с постоянным расстоянием между векторами.

· Создание макроса с помощью синтаксиса ANSYS CFX-Post.

Общее представление о проблемах решателя
В этом примере рассматривается внешнее обтекание потоком воздуха основы транспортного средства. Так как и геометрия и поток воздуха симметричны относительно вертикальной плоскости, то для писка решения задачи будем использовать только одну часть геометрии.
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Рисунок 1. Внешнее обтекание потоком воздуха основы транспортного средства
Описание симуляции в препроцессоре ANSYS CFX-Pre 

В следующем разделе будут описаны настройки симуляции в препроцессоре ANSYS CFX-Pre.

Проигрывание файла сессии 

Чтобы настройки симуляции выполнились автоматически, Вы можете запустить файл сессии. Для этого выберите в главном меню пункт Session > Play Tutorial (Сессия > Проиграть сессию из руководства), затем выберите файл сессии BluntBody.pre. 

Создание новой симуляции 

1. Запустите ANSYS CFX-Pre.

2. Выберите File > New Simulation (Файл > Новая симуляция). 

3. Выберите General в диалоговом окне с названием New Simulation File и нажмите OK. 

4. Выберите File > Save Simulation As (Файл > Сохранить симуляцию как…). 

5. В поле ввода File name задайте имя BluntBody и нажмите Save (Сохранить). 

6. Далее переходим к импорту сетки. 

Импорт сетки  
1. Выберите File > Import Mesh (Файл > Импорт сетки) или нажмите правой кнопкой мыши на вкладке Outline на пункт Mesh и выберите Import Mesh. 

2. В диалоговом окне Import Mesh выберите файл BluntBodyMesh.gtm в Вашей директории. 

3. Нажмите Open (Открыть). 

Создание домена 

В домене предполагается турбулентное и изотермическое течение. Воспользуемся моделью турбулентности Shear Stress Transport (SST) с автоматической пристеночной функцией, модель обеспечит высокую точность предсказания поведения потока при расслоении. Чтобы воспользоваться моделью SST, граничный слой должен иметь точность не менее 10 улов сетки. Чтобы уменьшить время расчета, в этом примере используется более грубая сетка. 

В этом примере в качестве жидкой среды используется идеальный газ, поскольку в предыдущих примерах уже использовались специфические среды. Когда моделируется сжимаемое течение, используется в качестве приближения идеальный газ для вычислений неоднородности плотности, поэтому важно задать реалистичное относительное давление. Есть несколько параметров, которые зависят от абсолютного давления среды (рассчитывается как сумма статического и относительного давлений). 

1. Выберите Insert > Domain (Вставка > Домен) в главном меню или нажмите Domain (Домен) [image: image2.png]


, задайте имя BluntBody
2. Примените следующие настройки BluntBody: 

	Вкладка
	Параметр
	Значение

	General Options
(Основные опции)
	Basic Settings > Fluids List
(Основные настройки > Список жидких сред)
	Air Ideal Gas
(Идеальный газ, воздух)

	
	Domain Models > Pressure > Reference Pressure
(Модель домена > Давление > Относительное давление)
	1 [atm]

	Fluid Models
(Модель расчета течения жидкой среды)
	Heat Transfer > Option
(Перенос тепла > Опции)
	Isothermal
(Изотермический)

	
	Heat Transfer > Fluid Temperature
(Перенос тепла > температура среды)
	288 [K]

	
	Turbulence > Option
(Турбулентность > Опции)
	Shear Stress Transport


3. Нажмите OK. 

Создание сложных регионов 

На импортированной сетке может содержаться много 2D регионов. С целью создания граничных условий, бывает удобно группировать несколько 2D регионов вмете и применить одно граничное условие для составного региона. В этом случае Вы содадите Union (Объединение) двух регионов, для которых требуется задать стенку со свободным скольжением. 

1. Выберите из главного меню пункт Insert > Composite Region (Вставка > Составной регион). 

2. Задайте имя FreeWalls (Свободные стенки) и нажмите OK. 

3. Примените следующие настройки
	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Dimension (Filter)
Объем (Фильтр)
	2D


4. В списке регионов, удерживая клавишу <Ctrl>, выберите регионы Free1 и Free2. 

5. Нажмите OK. 

Создание граничных условий 

В данной симуляции необходимо задать граничные условия для входа, выхода, стенки (без скольжения и со свободным скольжением) и плоскости симметрии. Регионы для этих граничных условий были определены при создании сетки. 

Создание граничного условия Inlet (Вход) 

1. Нажмите Boundary Condition (Граничные условия) [image: image3.png]


. 

2. В качестве имени Name задайте Inlet (Вход).
3. Примените следующие настройки
	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type
(Тип границы)
	Inlet
(Вход)

	
	Location
(Участок)
	Inlet
(Вход)

	Boundary Details
(Детали)
	Flow Regime > Option
(Режим течения > Опции)
	Subsonic
(Дозвуковой)

	
	Mass and Momentum > Option
(Уравнения масс и момента > Опции)
	Normal Speed
(Нормальная скорость)

	
	Mass and Momentum > Normal Speed
(Уравнения масс и момента > Нормальная скорость)
	15 [m s^-1]

	
	Turbulence > Option
(Турбулентность > Опции)
	Intensity and Length Scale
(Интенсивности и шкала длин)

	
	Turbulence > Eddy Len. Scale
(Турбулентность > Шкала длин вихревого течения)
	0.1 [m]


4. Нажмите OK. 

Создание граничных условий для выхода   
1. Создайте новое граничное условия с именем Outlet (Выход). 

2. Примените следующие настройки
	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type
(Тип границы)
	Outlet
(Выход)

	
	Location
(Участок)
	Outlet
(Выход)

	Boundary Details
(Детали)
	Mass and Momentum > Option
(Уравнения масс и момента > Опции)
	Static Pressure
(Статическое давление)

	
	Mass and Momentum > Relative Pressure
(Относительно давление)
	0 [Pa]


3. Нажмите OK. 

Граничное условие: стенка со свободным скольжением
Верхняя и боковая поверхность прямоугольного региона будут использовать граничные условия типа стенки со свободным скольжением. 

· На стенках со свободным скольжением shear stress (давление напряжение рассечения) устанавливается равным нулю, чтобы поток не замедлялся.

· Нормальная скорость к стенке также устанавливается равной нулю.

· Скорость потока параллельно стенке вычисляется в ходе решения.

Это не идеальные граничные условия для подобной ситуации, так как течение потока будет зависеть от близости к стенкам. Если моделировать воздушный туннель, то необходимо задать в качестве домена воздушный туннель со стенками без скольжения. Если в нашем случае моделируется обтекание грубого тела, находящегося в открытой атмосфере, то достаточно большой домен будет минимизировать влияние стенок. 

Примените одни граничные условия для обоих регионов, используя составной регион, созданный ранее.

1. Создайте новое граничное условия с именем  FreeWalls (Свободные стенки). 

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type
(Тип границы)
	Wall
(Стенка)

	
	Location
(Участок)
	FreeWalls
(Свободная стенка)

	Boundary Details
(Детали)
	Wall Influence On Flow > Option
(Воздействие стенки на течение > Опции)
	Free Slip
(Свободное скольжение)


3. Нажмите OK. 

Граничное условие: плоскость симметрии 

1. Создайте новое граничное условия с именем  SymP (Плоскость симметрии). 

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type
(Тип границы)
	Symmetry
(Симетрия)

	
	Location
(Участок)
	SymP


3. Нажмите OK. 

Условия стенки на поверхности тела 

1. Создайте новое граничное условия с именем  Body (Тело). 

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type
(Тип границы)
	Wall
(Стенка)

	
	Location
(Участок)
	Body
(Тело)

	Boundary Details
(Детали)
	Wall Influence On Flow > Option
(Воздействие стенки на течение > Опции)
	No Slip
(Без скольжения)


3. Нажмите OK. 

Для остальных 2D регионов будут выставлены граничные условия по умолчанию: адиабатическая стенка без скольжения. Имя граничного условия по умолчанию будет Default Boundary (Граница по умолчанию). Несмотря на то, что граничные условия Body (Тело) и Default Boundary (Граница по умолчанию) идентичны (за исключением их регионов), граничное условие Body (Тело) было создано, чтобы затем в процессе визуализации можно было легко переопределить Location (Участок) для задания адиабатической стенки без скольжения. 

Настройка начальных значений 

1. Нажмите Global Initialization (Глобальная инициализация) [image: image4.png]


.  

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Global Settings
(Глобальные настройки)
	Initial Conditions > Cartesian Velocity Components > Option
(Условия инициализации > Компоненты вектора скорости > Опции)
	Automatic with Value
(Автоматически со значением)

	
	Initial Conditions > Cartesian Velocity Components > U
(Условия инициализации > Компоненты вектора скорости > U)
	15 [m s^-1]

	
	Initial Conditions > Cartesian Velocity Components > V
(Условия инициализации > Компоненты вектора скорости > V)
	0 [m s^-1]

	
	Initial Conditions > Cartesian Velocity Components > W
(Условия инициализации > Компоненты вектора скорости > W)
	0 [m s^-1]

	
	Initial Conditions > Turbulence Eddy Dissipation
(Условия инициализации > Рассевание вихревого движения)
	(Поставьте галочку)


3. Нажмите OK. 

Настройки параметров решателя 

1. Нажмите Solver Control (Контроль решателя) [image: image5.png]


.  

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Basic Settings
(Основные настройки)
	Convergence Control > Max. Iterations
(Управление сходимостью > Максимальное количество итераций)
	60

	
	Convergence Control > Fluid Timescale Control > Timescale Control
(Управление сходимостью > Управление шагом по времени в жидкой среде > Управление шагом по времени)
	Physical Timescale
(Физический шаг по времени)

	
	Convergence Control > Fluid Timescale Control > Physical Timescale
(Управление сходимостью > Управление шагом по времени в жидкой среде > Физический шаг по времени)
	2 [s]

	
	Convergence Criteria > Residual Target
(Критерий сходимости > Цель остатка)
	1e-05


3. Нажмите OK. 

Запись файла для решателя (.def) 

Действия 

1. Нажмите Write Solver File (Записать файл для решателя) [image: image6.png]


. 
2. Примените следующие настройки:

	Параметр
	Значение

	File name
(Имя файла)
	BluntBody.def

	Quit CFX–Pre[a]
(Закрыть CFX–Pre)
	(Поставьте галочку)

	[a] Если запустили ANSYS CFX-Pre из ANSYS CFX-.11.0 Laucher.  


3. Убедитесь что выбран пункт Start Solver Manager (Запустить Менеджер задач) и нажмите Save (Сохранить).  

4. Если вы получили сообщение о том, что файл уже существует, нажмите Overwrite (Перезаписать). 

5. Нажмите Yes (Да) или Save & Quit (Сохранить и закрыть приложение), чтобы сохранить файл с расширением (.cfx). 

Получение решения с помощью ANSYS CFX-Solver Manager
В этом примере описывается процесс решения задачи в параллельном режиме.

Примечание
Результаты полученные при решении задачи в последовательном и параллельном режимах идентичны.

Если Вы хотите решить задачу в параллельном режиме на одном компьютере, то переходите к пункту: «Получение решения в параллельном режиме на локальном компьютере» (Obtaining a Solution with Local Parallel).
Если Вы хотите решить задачу в параллельном режиме на разных компьютерах, то переходите к пункту: «Получение решения в параллельном режиме в распределенной сети» (Obtaining a Solution with Distributed Parallel). 

Решение задачи в последовательном режиме (Serial) 

Когда завершится приложение ANSYS CFX-Pre и запустится ANSYS CFX-Solver Manager, Вы можете решить задачи вычислительной гидродинамики (CFD) с помощью следующих действий.

1. Нажмите Start Run (Запустить расчет). 

2. Нажмите Yes, чтобы увидеть результаты в постпроцессоре ANSYS CFX-Post. 

3. Закройте ANSYS CFX-Solver Manager.

Решение задачи в параллельном режиме 

Возможность решателя ANSYS CFX-Solver находить решение задачи в параллельном режиме позволяет разделять большую вычислительную (CFD) задачу гидродинамики на части и выполнять их на более чем одном процессоре/компьютере одновременно. Это экономит время, т.к. вычисление задачи на нескольких машинах устраняет проблемы, которые есть при решении той же задачи на одной машине. Например, необходимость использовать большой объем оперативной памяти компьютера. При делении на части эта проблема решается автоматически. 

Следующие операции будут выполнены, когда Вы укажете настройки для ANSYS CFX-Solver:

· Ваша сетка будет разделена на число подзадач, которое Вы выберете.

· ANSYS CFX-Solver запустит отдельно на каждой выбранной машине по одной подзадаче.

· Результаты, полученные одним решателем ANSYS CFX-Solver, влияют на расчеты других решателей посредством интерфейса между различными частями сетки. 

· Все процессы расчета решателей ANSYS CFX-Solver требуют согласованности с каждым из остальных решателей. Это обеспечивается управляющим процессом, который называется master (Мастер). 

· Мастер-процесс всегда запущен на той машине, где Вы зарегистрировались, когда запускали задачу на решение в параллельном режиме. Остальные решатели ANSYS CFX-Solver запущены на других машинах и называются  slave (Рабочий) процессами. 

· После того, как все подзадачи будут решены, все результаты записываются в один файл. Это будет точно такой же файл результатов, как тот, что Вы получали при решении задачи в последовательном режиме, за одним исключением: дополнительная переменная Real partition number (Число реальных частей) будет доступна для параллельного запуска. Эта переменная будет использоваться для визуализации в данном примере. 

Решение задачи в параллельном режиме на локальном компьютере (Obtaining a Solution with Local Parallel) 

Для запуска задачи в этом режиме Ваша машина должна иметь более чем 1 процессор.

В ANSYS CFX-Solver Manager в диалоговом окне Define Run примените следующие настройки: 

1. Оставьте Type of Run (Тип запуска) Full (Полный). 

If Type of Run was instead set to Partitioner Only, your mesh would be split into a number of partitions but would not be run in the ANSYS CFX-Solver afterwards. 
Если Type of Run (Тип запуска) был указан как Partitioner Only (Только разбиение на части), то Ваша сетка будет разделена на указанное количество частей, но не сможет быть рассчитана в ANSYS CFX-Solver в дальнейшем.

2. Установите Run Mode (Режим запуска) PVM Local Parallel . 

Этот метод рекомендуется использовать для большинства приложений.

3. Если необходимо увеличить количество частей, нажмите Add Partition (Добавить часть) [image: image7.png]


 . 

По умолчанию количество частей указано равным 2. 

4. Выберите Show Advanced Controls (Показать дополнительное управление). 

5. Нажмите на вкладке Partitioner (Разделение на части) вверху диалогового окна. 

6. Используйте значение по умолчанию MeTiS partitioner. 

Ваша модель будет разделена на 2 части, для каждой из частей запустится свой процесс ANSYS CFX-Solver. Этот метод, установлен по умолчанию, потому что он обеспечивает наибольшую эффективность при разделении на части чем Recursive Coordinate Bisection или User Specified Direction. 

7. Нажмите Start Run (Запустить расчет). 

8. Нажмите Post–Process Results (Просмотр результатов в постпроцессоре) [image: image8.png]


. 

9. Если Вы запустили решатель ANSYS CFX-Solver из Launcher, выберите Shut down Solver Manager (Закрыть Менеджер задач) и нажмите OK. 

Решение задачи в параллельном режиме в распределенной сети (Obtaining a Solution with Distributed Parallel) 

Перед запуском решения задачи в этом режиме, убедитесь, что Ваша система сконфигурирована так, как описано в документации по установке. 

В ANSYS CFX-Solver Manager в диалоговом окне Define Run примените следующие настройки: 

1. Оставьте Type of Run (Тип запуска) Full (Полный). 

2. Установите Run Mode (Режим запуска) PVM Distributed Parallel. 

Имя компьютера, на котором Вы сейчас работаете, должно быть текущим в списке Host Name (Имя компьютера). Вы будете запускать две подзадачи, поэтому необходимо добавить в список еще один компьютер. 

3. Нажмите Insert Host (Добавить компьютер), чтобы создать новый компьютер в списке. 

· Отобразится диалоговое окно Select Parallel Hosts (Выберите компьютер для параллельного запуска задачи). Здесь необходимо выбрать дополнительную машину для Вашего расчета. 

· Ваш системный администратор установит файл с хостами, ограничивающий список машин, доступных для параллельного запуска ANSYS CFX-Solver. 

· В колонке Host Name появятся имена доступных машин. 

· Вторая колонка показывает количество процессоров на соответствующей машине.

· Третья показывает относительную скорость процессора: процессор с относительной скоростью равной 1 будет вдвое быстрее машины с относительной скоростью равной 0.5. 

· Последняя колонка отображает информацию об операционной системе.

· Эта информация считывается из host-файла компьютера. Если некоторая информация отсутствует или неверна, то Ваш системный администратор должен скорректировать файл. 

Примечание
# процессор, относительная скорость и системная информация не гарантируют возможность запуска задачи на компьютере.

4. Выберите имя другого компьютера в списке Host Name. 

Выберите машину, к которой Вы имеете доступ (учетную запись).

5. Нажмите Add (Добавить). 

Имя машины будет добавлено в колонку Host Name. 

Примечание
Убедитесь, что компьютер, на котором Вы сейчас работаете, есть в списке Hosts Name диалогового окна Define Run. 

6. Закройте диалоговое окно Select Parallel Hosts, нажав на кнопку Close. 

7. Выберите Show Advanced Controls (Показать дополнительное управление). 

8. Нажмите на вкладке Partitioner (Разделение на части) вверху диалогового окна. 

9. Используйте значение по умолчанию MeTiS partitioner. 

10. Нажмите Start Run (Запустить расчет). 

11. Нажмите OK в появившемся сообщении. 

12. Нажмите Yes для визуализации результатов, когда появится сообщение об окончании расчета. 

13. Закройте ANSYS CFX-Solver Manager.

Текст выходного файла при расчете в параллельном режиме 

В области просмотра выходного текста появится содержимое выходного файла. Вы увидите похожую информацию:
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Информация ниже относится к разделению на подзадачи. После того как выполнится работа по дробления задачи на подзадачи, Вы увидите: 
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Это признак того, что работа по делению закончена. ANSYS CFX-Solver начинает запускать решение в параллельном режиме:
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На машине, где Вы работаете, запустился мастер-процесс, он контролирует процесс симуляции полностью. На второй машине запущен вспомогательный процесс (slave). Если у Вас более чем 2 процесса, то они будут запущены как дополнительные slave-процессы. 

В данном примере master-процесс рассчитывает часть сетки с номером 1, а частьсетки с номером 2 рассчитывается slave-процессом. Вы можете позже узнать в постпроцессоре ANSYS CFX-Post какие узлы и элементы находятся в каждой из частях в этом примере. 

Когда ANSYS CFX-Solver завершит работу, появится соответствующее сообщение. 

Просмотр результатов в постпроцессоре ANSYS CFX-Post 

В этом примере будет создан график векторов в ANSYS CFX-Post. Это даст Вам возможность увидеть, как ведет себя течение вокруг тела. Вы также создадите плоскость симметрии и научитесь манипулировать геометрией в окне просмотра. 

Использование плоскостей симметрии 

Ранее в этом примере Вы воспользовались плоскостью симметрии, потому что обтекаемое тело симметрично относительно плоскости. Ожидалось, что благодаря этому, необходимо вести расчет задачи только для половины тела. Однако, для визуализации полезно увидеть тело полностью. Препроцессор ANSYS CFX-Post позволяет воссоздать данные для целого тела, используя расчеты для его половины. Это делается с помощью объекта Instance Transform (Трансформация по требованию). 

Манипуляция геометрией 

1. Нажмите правую кнопку мыши в области окна просмотра и выберите пункт Predefined Camera > View Towards +X (Расположение камеры > По направлению оси X).
Создание трансформации по требованию 

Трансформация используется для визуализации полной геометрии в случае, когда симуляция рассчитывалась только для части геометрии, исходя из наличия симметрии. Существует 3 типа трансформации, которые Вы можете использовать: Rotation (Вращение), Translation (Сдвиг), Reflection (Отражение). В этом примере Вы создадите трансформацию посредством отражения относительно плоскости. 

1. Нажмите Location > Plane (Участок > План) и дайте имя Reflection Plane  (Плоскость отражения). 

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Definition > Method
(Описание > Метод)
	ZX Plane
(Плоскость ZX)

	Render
(Отображение)
	Draw Faces
(Отображение поверхности)
	(Уберите галочку)


3. Нажмите Apply (Применить). 

Создастся плоскость, являющаяся частью плоскости симметрии, описанной в ANSYS CFX-Pre. Сейчас трансформация по требованию будет использовать эту плоскость: 

4. Выберите из главного меню Insert > Instance Transform (Вставка > Трансформация по требованию) и оставьте имя объекта по умолчанию. 

5. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Definition
(Описание)
	Instancing Info From Domain
(Необходимая информация из домена)
	(Уберите галочку)

	
	Apply Rotation
(Применить вращение)
	(Уберите галочку)

	
	Apply Reflection
(Применить отражение)
	(Поставьте галочку)

	
	Apply Reflection > Plane
(Применить отражение > Плоскость)
	Reflection Plane
(Плоскость отражения)


6. Нажмите Apply (Применить). 

Использование отражающей трансформации 

Вы можете воспользоваться трансформацией для создания или редактирования графического объекта. Например, Вы можете изменить каркас Wireframe для просмотра, как это показано ниже: 

1. В дереве просмотра на вкладке Outline выберите User Locations and Plots (Пользовательские графики), примените следующие настройки к Wireframe (Каркас): 

	Вкладка
	Параметр
	Значение

	View
(Просмотр)
	Apply Instancing Transform > Transform
(Применить трансформацию по требованию > Трансформация)
	Instance Transform 1


2. Нажмите Apply (Применить). 

3. Измените масштаб, чтобы была видна вся геометрия полностью.

Вы увидите все обтекаемое тело.

Создание векторов 

Сейчас Вы создадите график векторов, показывающий векторы скорости позади тела. Сначала необходимо создать объект, который будет участком для размещения векторов, например, модельную плоскость. 

Создание плоскости для примера 

Модельная плоскость – плоскость, состоящая из точек, находящихся на заданном друг от друга расстоянии.

1. Нажмите правую кнопку мыши в области окна просмотра и выберите пункт Predefined Camera > View Towards +Y (Расположение камеры > По направлению оси Y).
Убедитесь, что изменения видны.

2. Создайте новую плоскость с именем Sample (Образец). 

3. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Definition > Method
(Описание > Метод)
	Point and Normal
(Точка и нормаль)

	
	Definition > Point
(Описание > Точка)
	6, -0.001, 1

	
	Definition > Normal
(Описание > Нормаль)
	0, 1, 0

	
	Plane Bounds > Type
(Граница плоскости > Тип)
	Rectangular
(Прямоугольный)

	
	Plane Bounds > X Size
(Граница плоскости > Размер по X)
	2.5 [m]

	
	Plane Bounds > Y Size
(Граница плоскости > Размер по Y)
	2.5 [m]

	
	Plane Type
(Тип плоскости)
	Sample

	
	Plane Type > X Samples
(Тип плоскости > Выборка по X)
	20

	
	Plane Type > Y Samples
(Тип плоскости > Выборка по Y)
	20

	Render
(Отображение)
	Draw Faces
(Отображение поверхности)
	(Уберите галочку)

	
	Draw Lines
(Отображение линий)
	(Поставьте галочку)


4. Нажмите Apply (Применить). 

Вы можете изменить масштаб, чтобы увидеть на плоскости выбранные точки (где линии пересекаются). На плане всего 400 (20 * 20) выбранных точек. Вектор может быть создан из каждой такой точки. 

5. Скройте плоскость убрав галочку объекта Sample. 

Создание графика векторов с помощью различных методов 

1. Нажмите Vector (Ветор)[image: image12.png]


 и оставьте имя по умолчанию. 

2. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Definition > Locations
(Описание > Участок)
	Sample
(Выбор)

	
	Definition > Sampling
(Описание > Выборка)
	Vertex
(вершина)

	Symbol
(Символ)
	Symbol Size
(Размер символа)
	0.25


3. Нажмите Apply (Применить). 

4. Измените масштаб в окне просмотра для просмотра графика векторов.

You should be able to see a region of recirculation behind the blunt body.

5. Пренебрегите вершинами модельной плоскости и увеличчьте плотность векторов, применив следующие настройки:

	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Definition > Sampling
(Описание > Выборка)
	Equally Spaced
(Равноудаленный)

	
	Definition > # of Points
(Описание > Кол-во точек)
	1000


6. Нажмите Apply (Применить). 

7. Измените месторасположение для отображения графика векторов, применив следующие настройки:

	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Definition > Locations
(Описание > Участок)
	SymP
(Плоскость симметрии)


8. Нажмите Apply (Применить). 

Создание графика давления 

1. Примените следующие настройки к граничному условию Body (Тело): 

	Вкладка
	Параметр
	Значение

	Color
(Цвет)
	Mode (Режим)
	Variable (Переменная)

	
	Variable (Переменная)
	Pressure (Давление)

	View
(Просмотр)
	Apply Instancing Transform > Transform
(Применить трансформацию по требованию > Трансформация)
	Instance Transform 1


2. Нажмите Apply (Применить). 

3. Примените следующие настройки to SymP: 

	Вкладка
	Параметр
	Значение

	Render
(Отображение)
	Draw Faces
(Отобразить поверхность)
	(Уберите галочку)

	
	Draw Line
(Отобразить линии)
	(Поставьте галочку)


4. Нажмите Apply (Применить). 

Вы увидите сетку вокруг обтекаемого тела, масштаб сетки уменьшается около тела, но достаточно грубая в регионах циркуляции. Увеличив масштаб, Вы увидите слои объемных элементов около тела. 

Создание линий тока на поверхности 

Чтобы увидеть поток воздуха, протекающий вдоль поверхности тела, создадим линии тока на поверхности:

1. Скройте объекты Body, SymP и Vector 1. 

2. Создайте новую поверхность Starter. 

3. Примените следующие настройки
	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Definition > Method
(Описание > Метод)
	YZ Plane
(Плоскость YZ)

	
	X
	-0.1 [m]


4. Нажмите Apply (Применить). 

Плоскость появится вверху по направлению потока.

5. Скройте эту плоскость.

В окне просмотра плоскость не будет видна, несмотря на то, что она существует.

6. Нажмите Streamline (Линии тока)[image: image13.png]{it



. и нажмите OK, чтобы согласиться с именем по умолчанию. 

7. Примените следующие настройки:

	Вкладка
	Параметр
	Значение

	Geometry
(Геометрия)
	Type (Тип)
	Surface Streamline
(Линии тока на поверхности)

	
	Definition > Surfaces
(Описание > Поверхности)
	Body
(Тело)

	
	Definition > Start From
(Описание > Начать от)
	Locations
(Участки)

	
	Definition > Locations
(Описание > Участок)
	Starter

	
	Definition > Max Points
(Описание > Максимальное кол-во точек)
	100

	
	Definition > Direction
(Описание > Направление)
	Forward
(Передний план)


8. Примените следующие настройки. 

Появятся линии тока на поверхности на одной поверхности тела. Они начинаются в конце потока сверху, так как точки начала линий были сформированы как проекция узлов поверхности на тело. 

Перемещение объектов 

В ANSYS CFX-Post Вы можете менять репозицию некоторых участков объектов непосредственно в  окне просмотра.

1. Сделайте видимым плоскость с именем Starter. 

2. Выберите [image: image14.png]


 Single Select (Единичный выбор) для указателя мыши  на панели инструментов Selection Tools. 

3. В окне просмотра выберите на плоскость Starter, затем с помощью левой кнопки мыши, переместите плоскость вдоль оси X. 

Заметим, что линии тока будут перерисованы вместе с плоскостью.

Создание графика поверхности y+ 

Скорость вблизи стенки без скольжения быстро изменяется от значения равного нулю на стенке до значения скорости свободного потока на очень близком расстоянии от стенки. Этот слой с большим градиентом скорости – граничный слой. Многие сетки не достаточно точны вблизи стенки, чтобы получить точное значение профиля скорости в граничном слое. В этом случае можно воспользоваться пристеночной функцией, чтобы применить допустимую функцию профиля скоростей на модели. Другие сетки, которые достаточно точны, не требуют применения пристеночной функции, и применение ее не имеет большого эффекта. В большинстве случаев возникают проблемы, когда задача сочетает в себе обе противоположные стороны, граничный слой – это часть узлов вблизи стенки и пристеночные функции, которые используют дополнительную точность там, где узлы не полностью сгруппированы вблизи стенки. 

One indicator of the closeness of the first node to the wall is the dimensionless wall distance [image: image15.png]


. It is good practice to examine the values of [image: image16.png]


at the end of your simulation. At the lower limit, a value of [image: image17.png]


less than or equal to 11 indicates that the first node is within the laminar sublayer of the boundary flow. Values larger than this indicate that an assumed logarithmic shape of the velocity profile is being used to model the boundary layer portion between the wall and the first node. Ideally you should confirm that there are several nodes (3 or more) resolving the boundary layer profile. If this is not observed, it is highly recommended that more nodes be added near the wall surfaces in order to improve simulation accuracy. In this tutorial, a coarse mesh is used to reduce the run time. Thus, the grid is far too coarse to resolve any of the boundary layer profile, and the solution is not highly accurate. 

Поверхностный график y+ 

График поверхности отображается тем цветом, который соответствует переменной: в нашем случае, это [image: image18.png]


. График  [image: image19.png]


получен следующим образом: 

1. Скройте все объекты и графики.

2. Выберите на вкладке Outline объект BluntBodyDefault и примените следующие настройки: 

	Вкладка
	Параметр
	Значение

	Color
(Цвет)
	Mode (Режим)
	Variable (Переменная)

	
	Variable (Переменная)
	Yplus[a] (Y плюс)

	View
(Просмотр)
	Apply Instancing Transform > Transform
(Применить трансформацию по требованию > Трансформация)
	Instance Transform 1

	[a] Нажмите на иконку справа от Variable, в выпадающем списке отобразятся все переменные, включая Yplus. 


3. Нажмите Apply (Применить). 

4. Выберите на вкладке Outline объект Body и примените следующие настройки: 

	Вкладка
	Параметр
	Значение

	Color
(Цвет)
	Mode (Режим)
	Variable
(Переменная)

	
	Variable (Переменная)
	Yplus[a] (Y плюс)

	View
(Просмотр)
	Apply Instancing Transform > Transform
(Применить трансформацию по требованию > Трансформация)
	Instance Transform 1

	[a] Нажмите на иконку справа от Variable, в выпадающем списке отобразятся все переменные, включая Yplus. 


5. Нажмите Apply (Применить). 

Демонстрация возможностей синтаксиса 

В этом разделе демонстрируются возможности макроса использовать оценку вариативности какой-либо переменной по направлению оси x. 

Краткий обзор 

Макрос содержит команды на языке CCL и может проигрываться как файл сессии. Этот макрос будет записан с помощью редактора Command Editor. Макрос укажет ANSYS CFX-Post создать плоскости слоя с нормалью по оси X на 20 единиц удаленных от начала  и конца домена. На каждой из плоскостей, вычислит и напечатает минимум, максимум и среднее значение указанных переменных. Плоскости раскрасятся в соответствии с значениями выбранных переменных. 

Примечание
Препроцессор ANSYS CFX-Post может выполнить команды CCL непосредственно или с помощью графического интерфейса. Редактор Command Editor используется непосредственно для ввода корректных команд CCL. 
Действия 

1. Проиграйте файл сессии с именем BluntBodyDist.cse. 

2. Нажмите правую кнопку мыши в области окна просмотра и выберите пункт Predefined Camera > View Towards -X (Расположение камеры > По направлению оси X).
3. Выберите в главном меню пункт Tools > Command Editor (Инструменты > Редактор команд). 

4. Напечатайте следующую строку в редакторе Command Editor (the quotation marks and the semi-colon are required): 

[image: image20.png]1BluntBodyDist ("Velosity u"):




5. Нажмите Process (Выполнить). 

Максимальная, минимальная и средняя величины переменной на каждом участке оси X запишутся в файл BluntBody.txt. Результаты можно увидеть при просмотре файла в текстовом редакторе. 

Вы можете написать макрос для различных переменных.

Чтобы просмотреть содержимое файла сессии (который содержит поясняющие комментарии), откройте его через текстовый редактор. Он написан на языке CCL и даст возможность понять как работает макрос. 

Просмотр частей сетки (Parallel Only) 

Если Вы выполнили в параллельном режиме задачу, то в ANSYS CFX-Post будет доступна дополнительная переменная Real partition number (Действительное количество частей) 

1. Создайте изоповерхность (Isosurface) с параметром Real partition number равным 1. 

2. Создайте изоповерхность (Isosurface) с параметром Real partition number равным 1.999. 

Две изоповерхности показывают границы двух частей. Промежуток между двумя графиками показывает пересекающиеся узлы. Они содержатся в обоих частях 1 и 2. 

Когда завершите работу, закройте ANSYS CFX-Post.
